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Lesson 1 — Get Started Lesson Objectives

Lesson Objectives

® Gain an overview of the course and the topics to be covered

® Understand how QuickBooks Desktop works and how to get around in QuickBooks
® Learn common business terms used by QuickBooks

® Practice using the QuickBooks Help tools

@® See how to exit QuickBooks

QuickBooks 2017 Student Guid . 4
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Lesson 1 — Get Started Forms

Forms

You record most of your daily business transactions in QuickBooks Desktop on a QuickBooks form,
which looks just like a paper form. Here's an example of the form you use when you want to record a
bill from one of your vendors.

Enter Bills

Reports
«» B B X Qoewescn & g B O B &
Find Mew Save Delete aMemorize Print Attach Select  Enter Clear Recalculate Pay
M M File PO Time Splits Bill
® Bl Credit [+ Bill Received
VENDOR | & Electric| - DATE 12/15/2021 & SUMMARY
I FPhone 415-555-0202
. REF. NO.
sppress | Cal Gas & Electric Open balance 122,68
P.O. Box 5037
AMOUNT DUE i
Middlefield CA 94482 12268 POs to be received 0
BILL DUE 12/30/2022 B
TERMS Met 15 - DISCOUNT DATE
VEMD - Acct #560-82645-99C
RECENT TRANSACTION &
Expenses $122.68  ltems $0.00
. , : : : 12/15/21 Bill 122.68
mwu\Tm i AMOUNT i MEMO | CUSTOMER.JOE ! E;i_...: CLASS . 11125021 Check 9753
65100 - Utilities:65110 ... 122.68 Overhead Overhead 10125021 Check 5657
09/05/21 Bill Pmt -Check 12268
08/25/21 Bill - Paid
v
Save & Close Save & New Revert
NOTES
QuickBooks 2017 Student Guide 5
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Lists

The list is another basic QuickBooks feature. You fill out most QuickBooks forms by selecting entries
from a list.

NOTE: In the Enter Bills window above, the information in the Vendor, Terms, Account and
Customer/Job fields are pulled from lists.

QuickBooks uses lists to store information about customers, vendors, employees, items or services
you sell and so on. Lists save time and help you enter information consistently and correctly.

When you're filling out an invoice form and you select a customer name from the Customer/Job list,
QuickBooks not only fills in the name, but also the address, payment terms and customer’s sales tax,
based on the information previously entered in the customer’s record in the Customer Center.

Here's an example of the Customers & Jobs list in the Customer Center. You can customize columns
in the list by right-clicking on a column header and choosing Customize Columns.

Customer Center: Abercrombie, Kristy
& NewCustomer&Job ¥ | NewIransactions v (&) Print Excel * Word * & Income Tracker
Customers & Jobs
Active Customers - <
fe)
NAME BALANGE TOT... | NOTES ATTACH
I T T
+Family Room 0.00 '
«Kitchen 0.00
+Remaodel Bathroom 0.00
+ Allard, Robert 14,510.00
+Remodel 14,510.00
+ Babcock's Music Shop 0.00
+Remodel 0.00
+ Baker, Chris 0.00
+Family Room 0.00
+Garage Repair 0.00
+ Balak, Mike 0.00
< Utility Shed 0.00
+ Barley, Renee 0.00
+Repairs 0.00
+ Bauman, Mark 0.00
+Home Remodel 0.00
+ Bolinski, Rafal 0.00
+2nd story addition 0.00
x
QuickBooks 2017 Student Guide 6
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Lesson 1 — Get Started Registers

Registers

In addition to forms and lists, you'll also work with registers in QuickBooks. Just as you use your
paper checkbook register to see a record of all the transactions in your checking account — checks
you've written, other withdrawals you've made as well as deposits — a QuickBooks register is a
record of all the activity in that one account. Almost every QuickBooks account on the balance sheet
(all assets, liabilities and equity accounts) has its own register. (The exception is Retained Earnings.)
See the next section All the Accounting You Need to Know, for more information.

Accounts Receivable is the record of money owed to that business; that is, the outstanding invoices
for which a business has not yet received payment from customers.

Here's an example of the register for an Accounts Receivable account.

11000 - Accounts Receivable

e Go to... | é Print... | 52 Edit Transaction E QuickReport
DATE HUMBER CUSTOMER MEW a RATE ANT RAID
TYPE DESCRIFTION CLASS DUE DATE
1211412021 1094 Matiello, Ernesto:Kitchen 2,080.11
MV Paid
1211412021 1095 Matiello, Ernesto:Kitchen 8,656.25
1INV Paid
121472021 1096 Matiello, Ernesto:Kitchen 2,824.03
1MV Paid
12M5/2021 Roche, Diarmuid:Garage repairs 440.00
PMT
121512021 Abercrombie, Kristy:Remodel Bathroom 7,633.28
PMT
1211512021 1097 Robsaon, Darci:Robson Clinic 12,420.98
MV 12152022
121512021 1098 Cook, Brian:Kitchen 1,636.69
1INV 0114/2023
121572021 42000  Matiello, Ernesto:Kitchen 13,560.39
PMT
B | Number |Customer v |ltem v |aty Rate Amt Chrg
Description ClL. = B -]
1-Line Show open balance ENDING BALANCE 93,00793
Sortby  pate, Type, Number/Ref = Restore

NOTES

QuickBooks 2017 Student Guide
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Lesson 1 — Get Started Get Around in QuickBooks

Get Around in QuickBooks

QuickBooks provides access to information to help you get started.

@
o0  Step-by-Step: Get Started

1. Select F1 on your keyboard or, in the Help menu, select QuickBooks Desktop Help.

Have a Question?

4 & e

Get started with QuickBooks o

After you create a company file, you can start using QuickBooks right away. However, we
recommend that you continue setting up your business B to make sure your finandal
statements are accurate.

To help you get started, you can:
= et help for common tasks.
m Download the QuickBooks User Guide and Quidk Start Guide.

m Visit the QuidkBooks support site to search in-depth support artides or get help from a
QuickBooks Support Representative.

m Visit the Intuit Community to connect with other QuickBooks users and small business
OWNErs,

m Learn about training solutions to help you use and customize QuickBooks for your
business,

m Find a local QuickBooks expert.

Have a comment or suggestion? Send us feedback,

fizd Chedk the Suppaort Site for mare answers
i{t=1 Did this Help topic give you the information you needed?

Cros § o

Requires an Internet connection.

QuickBooks 2017 Student Guid . 8
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Lesson 1 — Get Started Get Around in QuickBooks

2. Click on the # sign next to Download the QuickBooks User Guide and Quick Start Guide.

Have a Question?

4 & v P

Get started with QuickBooks ~

After you create a company file, you can start using QuickBooks right away, However, we recommend that you
continue setting up your business B to make sure your finandal statements are accurate.

To help you get started, you can:
n Get help for commaon tasks.

® Download the QuickBooks User Guide and Quick Start Guide.

= Visit the QuickBooks support site to search in-depth support a@ges or get help from a QuickBooks Support
Representative,

= Visit the Intuit Community to connect with other QuickBooks users and small business owners,

m Learn about training selutions to help you use and customize QuidkBooks for your business.

® Find a local QuidBooks expert.

Have & comment or sugaestion? Send us feedback,

25 Chedk the Support Site for more answers

#=2 Did this Help topic give you the information you needed?

(ves L o

Reguires an Internet connection.

QuickBooks 2017 Student Guid i
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Lesson 1 — Get Started Get Around in QuickBooks

3. Click the link to get your guides.

Have a Qu

4 & v 0

Get started with QuickBooks ~

After you create a company file, you can start using QuickBooks right away. However, we recommend that you
continue setting up your business B to make sure your finandal statements are accurate.

To help you get started, you can:
m Get help for common tasks.
= Download the QuickBooks User Guide and Quick Start Guide, B

We have 2 quides to help you getting up and running with QuickBiooks.

n In the QuickBooks Quick Start Guide, we'll show you how to install QuickBooks and get started
in just a few easy steps,

m Want the guided tour? The QuickBooks Uiser Guide shows you how to get paid, pay others, and
see how your business is doing.

Just dick this link to get *{Hi r quides.

m  Visit the QuickBooks suppart site to search in-depth support artides or get help from a QuickBooks Suppaort
Representative.

m Visit the Intuit Community to connect with other QuidkBooks users and small business owners,
m Learn about training solutions to help you use and customize QuickBooks for your business.
m Find a local QuickBooks expert.

Have a comment or suggestion? Send us feedbadk.

2% Check the Support Site for mare answers
¢ Did this Help topic give you the information you needed?

Cros L o'

Requires an Internst connection.

QuickBooks 2017 Student Guid . 10
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Lesson 1 — Get Started Get Around in QuickBooks

4. By selecting QuickBooks for Windows you have the option to open, download and save as PDF
either or both of these resources: QuickBooks Quick Start Guide 2016 or QuickBooks User Guide
2016. These resources will help guide you through many tasks, including the following:

@ EBack P Fowad &% Stop £ Refresh &) Print see

hitps:i/community.intuit.com/questions/102037 8- -user-m Is-and-guides \
TSI T T T TS TS TS TS S TS o S e s ~  QuIckBooks, United States
@ a year ago Y

v RECOMMENDED ANSWER

36 people found this helpful

You can access manuals, guides and demos for selected editions of QuickBooks products.
Detailed information

QuickBooks for Winﬂows

QuickBooks for Ma

INF12758

QuickBooks Help Was this answer helpful? | ves || No
N
1 Employee a year ago

® Manage your open windows - QuickBooks can be set to display one window at a time or
several windows (organized side-by-side or cascaded)

® Use the menu bar - You can find all commands on the menu bar

File Edit View Lists Favorites Company Customers Vendors Employees Banking Repors Window Help

® Use the top icon bar - The top icon bar allows you to manage your business more quickly and
provides quick access to the centers

. . — - = S
“® 2 " E 51] ¢ - & i h B r G b= 8 @ €
Home My Company Income Tracker Bill Tracker Calendar | Snapshots Customers Vendors Employees | Docs Reports Order Checks UserLicenses | Invoice Mem  Check  Bil Reg Accnt Rmr
QuickBooks 2017 Student Guide 11
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Lesson 1 — Get Started Get Around in QuickBooks

@ Use the left side navigation - The left side navigation acts like the top icon bar, allowing you
quick and easy shortcuts. Use the top icon bar, the left side navigation or neither. You cannot use
both the top icon bar and the left side navigation.

My Shortcuts

@ Home

“" My Company

® Income Tracker
Bill Tracker

Calendar

[ ]

[ ]

D' Vendors
H

Employees

H Repors

@ orver checks

_' User Licenses
™ -

B invoice

. ttem

Do More With QuickBooks

g Tum on Payroll

& Accept Credit Cards

g2 Order Checks & Supplies

’ Clients Outgrowing QB Pro?

® QuickBooks Centers - For Customers, Vendors, Employees, Reports and Bank Feeds, these
Centers give quick access to common tasks

QuickBooks 2017 Student Guid . 12
e neen e www.ArdentBiz.com



Lesson 1 — Get Started Get Around in QuickBooks

® Make the Home page your starting point - The Home page provides a graphical
representation of the workflow, organized into logical groups

l Home

Mt Insights

VENDORS COMPANY You are using a sample
=, - - company file
iy ® B ®
Purchase Receive Enter Bills Manage Chart of Inventory Create a new company file
Orders Inventory Against Sales Accounts Activities
Inventory Tax
% E ACCOUNT BALANCES
ltems & Order : c
NAME i BALANCE
Enter Bills Pay Bills Senices Checks D ——
10300 - Savings 1791019 °
10400 - Petty C... 500.00
CUSTOMERS
% Calendar 11000 - Accoun. 93,007.93
v
Sales E Create Sales
Orders Accept Receipts EANKING
Credit Cards DO MORE WITH QUICKBOOKS
) i B @) munon paumal
Estimates Create Receive Record Reconcile
- ep
Invoices Payments Deposits &) Accent Credit Cards
©) ovter checks s supples
& ol = _ :
Statement Finance Statements Refunds ) o Clients Outorowing OB Pro
Ch ch & Credit Write Check
arges arges redits Checks Register
EMPLOYEES

é % T E‘% @ 5 a} M ﬂ =2 BACKUP STATUS -

Payroll Enter Pay Pay Process  HR Essentials C:thks Ci::,eéﬁﬁggs (f Local: August08, 2016, 4:29 AN
Center Time Employees Liabilties Payroll and Insurance Back up now
Forms
‘Online: Back up online with
Intuit Data Protect
QuickBooks 2017 Student Guide 13
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Lesson 1 — Get Started

Get Around in QuickBooks

® Get an overview of your company - The Insights tab of the Home page gives you real-time
information about how your company is doing and provides a location where you can keep track
of the tasks you need to perform. You can also get more detailed information from the Company
Snapshot found in the Reports drop-down menu.

Rock Castle Construction
Wednesday, December 15 2021

Profit & Loss | This Fiscal Year-to-date

113,560.69 £
NET INCOME
450,033.10
INCOME 50
336,472.41
EXPENSES
in 1.000s
Income
UNPAID
93,007.93 0.00
QPEN INVOICES OVERDUE

Company Payments

Add Content 3 | Restore Default

Income and Expense Trend

Home

Company Snapshot

Customer

w* ¥ PrevYear Income Comparisoh v X

$in 1000s This year-to-date « | All ~ Yearly A
70 $ in 10008
60 500
%0 400
40
30 300
20 200
10 100 I
° [

Gmn FE Mar Ax M3y An S Aug S O Nev Do
15

I Income WM Expense

Account Balances

0
2018 2017 2018 2019 2020 2021

N Prior Year(s) W Current Year

* ¥ Top Customers by Sales v X

(=Rt

Accrual Basis B

Search | P
How do | custamize this pags‘

Customers ¥Who Owe Money
CUSTOMER DUE DATE
Allard, Robert 09/27/20
WMackey's Nurseryand ... 11/04/2022
Pretell Real Estate 11/09i2022
Cook, Brian 1171402022
Hendro Rivadi 117182022
Vitton, David 1173002022
Teschner, Anton 1213120
Robson, Darci 12M15/20...
WMelton, Johnny 12/20/20...
Burch, Jason 12125120

Prev Year Expense Comparison

This yearto-date ~ | =

F

e

. e - A
ACCOUNT BALANCE $in 1000s
© Accounts Receivable 93,007.93
@ Turn on Payroll * Checking 46,969.10 i
. ——— ——— 1 300 v
d. s .
QuickBooks 2017 Student Guide 14
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Lesson 1 — Get Started All the Accounting You Need to Know

All the Accounting You Need to Know

ABOUT THE CHART OF ACCOUNTS

® Chart of Accounts
® The Chart of Accounts is a complete list of your business accounts and their balances

® An account is a tracking category for your business’s assets, liabilities, equity, income and
expenses

® When you keep books for a company, you want to track:
® Where the income comes from
® Where you put it
® What the expenses are for
® What you use to pay them

® You track this flow of money through the Chart of Accounts

Chart of Accounts

NAME L& TYRE i BALANCE TOTAL i ATTACH
+ 10300 - Savings £ Bank 17,910.19 l
+ 10400 - Petty Cash Bank 500.00
+ 11000 - Accounts Receivable Accounts Receivable 93,007.93
» 12000 - Undeposited Funds Other Current Asset 2,440.00
+ 12100 - Inventory Asset Other Current Asset 30,683.38
» 12800 - Employee Advances Other Current Asset 832.00
» 13100 - Pre-paid Insurance Other Current Asset 4,050.00
» 13400 - Retainage Receivable Other Current Asset 3703.02
<+ 15000 - Furniture and Equipment Fixed Asset 34 326.00
+ 15100 - Vehicles Fixed Asset 7893691
< 15200 - Buildings and Improvements Fixed Asset 325,000.00
+ 15300 - Construction Equipment Fixed Asset 15,300.00
» 16900 - Land Fixed Asset 90,000.00
¢ 17000 - Accumulated Depreciation Fixed Asset -110,344 60
< 18700 - Security Deposits OtherAsset 1,720.00
R
Account ¥ Activities ¥ Reports ¥ | Aftach [T Include inactive
QuickBooks 2017 Student Guide 15
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Lesson 1 — Get Started All the Accounting You Need to Know

ABOUT ASSETS, LIABILITIES AND EQUITY

® Assets
® Include both what you have or own and what others owe you

® The money people owe you from outstanding invoices is called your accounts receivable or
A/R for short. QuickBooks uses an accounts receivable account to track the money owed to
you by customers from invoices. You may have additional notes receivable if the business has
issued loans that are due for repayment.

® The rest of your company’s assets may include checking accounts, savings accounts, petty
cash, fixed assets (such as equipment or trucks), inventory and undeposited funds (money
you've received from customers but haven't yet deposited in the bank)

® Liabilities
® What your company owes to others
® The money you owe for unpaid bills is your accounts payable or A/P for short. QuickBooks

uses an accounts payable account to track the money you owe to vendors or suppliers for
bills.

® Aliability can be a formal loan, an unpaid bill, or sales and payroll taxes you owe to the
government. When setting up your company file in QuickBooks, note that even though
unpaid bills are liabilities, they will be set up as accounts payable type accounts in
QuickBooks.

® Equity
® Equity is the difference between what you have (your assets) and what you owe (your
liabilities): Equity = Assets - Liabilities

QuickBooks 2017 Student Guid . 16
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Lesson 1 — Get Started All the Accounting You Need to Know

CASH VERSUS ACCRUAL BOOKKEEPING

@® Cash basis

® Income is recorded when money (from sales) is received; expenses are recorded when
money (from bills) is paid. In other words, income and expenses are recognized based on the
date money changes hands.

@® Accrual basis

® Income is recorded at the time of the sale; expenses are recorded when you receive the bill.
In other words, income and expenses are recognized based on the date of the paperwork.

TIP: You can change or set the default reporting basis (accrual or cash) for summary reports
in the preferences of the company, based on the bookkeeping method you have chosen for
tax purposes. You can change the reporting basis of individual reports (except transaction

detail reports) by customizing the reports.

MEASURE BUSINESS PROFITABILITY

® The Balance Sheet - A snapshot of your company on one date. It shows:

® What your business has, including what others owe your business (assets and accounts
receivable)

® What your business owes to others, including to vendors/suppliers (liabilities and accounts
payable)

® The networth of your business (equity)

® The Profit & Loss Statement - Also known as the Income Statement, it covers activity over a
particular date range with a start date and an end date. It shows:

® Income
® Expenses
® Net profit or loss (income less expenses)

® The Statement of Cash Flows - This also covers activity over a particular date range with a start
date and an end date. It shows:

® Receipts
® Payments

QuickBooks 2017 Student Guid . 17
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Lesson 1 — Get Started All the Accounting You Need to Know

GENERAL JOURNAL TRANSACTIONS

® Traditional accounting method

® Known as double-entry accounting

® Total amountin the Debit column equals the total amount in the Credit column
® Each amountis assigned to an account in the Chart of Accounts

@® To view the journal entry for a transaction, open the transaction and press Ctrl+y or, from the
Reports tab in the transaction window, click on Transaction Journal

® [f necessary, click on Customize Report and choose to display the Credit and Debit columns
(rather than the Amount column)

Create I
Main Formatting Send/Ship Reports

& P B E g@ CreateaCopy @ E = Print Latsr @ B Add TimeiCosts Creale a Batch

Find New Save Delete ¢0BMemorize Mark As Print  Email EmailLater | Aftach @ Apply Credits  Progress ive B Refund/Credit

nding
Transaction Journal

Sl | Customize Report Commenton Report | Share Template | Memorize Print ¥ E-mail ¥ | Excel ¥ | Hide Header Refresh

Dates ' From B To E SortBy Default -

Show | Applied Filters

255 PM Rock Castle Construction
Tansiz Transaction Journal
All Transactions
Trans # Type Date Hum Hame Memo ttem ltem Description Account Class - Sales Price

b 1058 Invoice 12452021 1088 Cook, Brian:Kitchen 11000 - Accounts. Remodel

f— Cook, Brian:Kitchen  Gas Rangetop  Appliance 40140 - Materials L. Remodel 247.50
Appliance Cook, Brian:Kitchen ~ Double oven  Appliance 40140 - Materials | Remodel 350.00
Cook, Brian:Kitchen Dishwasher Appliance 40140 - Materials I Remode! 450.00
Cook, Brian:Kitchen ~ Greenhouse.. Window..  Window 40140 - Materials L. Remodel 475.00

Appliance
Appliance

- Cook, Brian:Kitchen  Removallabor  Remova..  Removal labor 40130 - Labor Inco...  Remodel 4550
Window

Cook, Brian:Kitchen Framing labor Framing... Framing labor 40130 - Labor Inco...  Remodel 66.00
] Cook, Brian:Kitchen Installation la. Installati Installation labor 40130 - Labor Inco. Remodel 38.50
Cook, Brian:Kitchen Installtile or ...  Subs:Til.. Install tile or counter 40150 - Subcontra.. Remodel 1,320.00

:::’J,‘ru Cook, Brian:Kitchen Painting SubsPa Painting 40150 - Subcontra. Remodel 825.00
CUSTOMER Cook, Brian:Kitchen Plumbing Subs:Plu... Plumbing 40150 - Subcontra.. Remodel 1,100.00
Cook, Brian:Kitchen Install drywall Subs:Dr... Install drywall 40150 - Subcoentra... Remodel 1,000.00

State Board of Equ CA sales tax. San Dom. CAsales tax, San 25500 - Sales Tax. Remodel 75%

NOTES

QuickBooks 2017 Student Guid . 18
ereee neen e www.ArdentBiz.com



Lesson 1 — Get Started Get Help while Using QuickBooks

Get Help while Using QuickBooks

QuickBooks provides extensive help in various formats. When you have questions,
QuickBooks provides:

® Onscreen Help to provide conceptual information and step-by-step instructions

® New Features section highlights new and improved features in the current version year
of QuickBooks

® The QuickBooks Quick Start Guide
® The QuickBooks User Guide

® Support and Ask Intuit links for answers to specific questions

The onscreen Help provides several different types of information:

® Conceptual explanations of how to apply QuickBooks to your particular business situation
® Step-by-step instructions

® A search engine that provides a list of topics related to the word or phrase you enter

® Information relevant to the task you are currently performing

® Access to community forums where you can exchange information with QuickBooks experts

QuickBooks 2017 Student Guid . 19
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Lesson 1 — Get Started Get Help while Using QuickBooks

@
2! Step-by-Step: Find a Topic in Onscreen Help

1. Press F1 or from the Help menu then choose QuickBooks Help. This brings up the Have a
Question? window.

2. Inthe Have a Question? window, use the search box to type in a full question or one or more
keywords. QuickBooks displays a list of help articles and community forum answers.

Have a Question?

4 B check e

© Answers in Help

Handle a bounced (NSF) check from a customer

Write, record, and print checks

Troubleshoot check printing problems

Your Spell check Dictionary File

Typing "To Print” in the Check Number Field does not mark a check "Print Later”

“ Show more answers

@ Answers from Community

Convert check to paycheck?
Checks that | thought were paychecks (Federal W/H, S5 Employee and Medicare emp...
+ 2 answers

Check numbers out of sync.

| am a new QB user, there is another user in the office (but he is on vacation!). We are...
~ 1 answer

Can | print voucher checks with the check in the middie?

This may be a basic question, but | have a large number of checks that | would like to_ .
~ 2 answers

* Show more community answers

G Contact us X\

NOTES

QuickBooks 2017 Student Guid . 20
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Lesson 1 — Get Started Exit QuickBooks

Exit QuickBooks

Unlike most other Windows programs, QuickBooks doesn't require you to save your data before
exiting. It does an automatic save while you're working (after every transaction is created, changed
or deleted) and every time you leave the program.

® To exit QuickBooks, from the File menu, choose Exit

To prevent or minimize data loss, you should make regular backup copies of your QuickBooks
company data. In the event of data loss, you can restore your data from the backup copy.

® To make a backup copy, from the File menu choose Back Up Company. A copy is a compressed
complete copy of your data file used to restore your working file in case it is compromised. Itis a
best practice to store your backups on a different drive from your working file.

NOTES

QuickBooks 2017 Student Guid . 21
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Move between Company Files

If you work with several companies, you'll work with multiple QuickBooks company files. You can
change from one company file to another at any time, but you can have only one company file open
at a time. (Two exceptions are QuickBooks Accountant Desktop and QuickBooks Desktop Enterprise
Solutions, which allow you to open two company files at one time.)

QuickBooks provides an easy way to find and open a company file you've worked with before.

@
2! Step-by-Step: Open a Previously Opened File

1. From the File menu, choose Open Previous Company.

2. From the submenu, select the company file you want to open.

@
o  Step-by-Step: Change the Number of Company Files Displayed

in the Submenu

1. Make sure you're logged into a QuickBooks company file as the Admin user.
2. From the File menu, choose Open Previous Company.

3. Choose Set number of previous companies.

4. Enter the number of company files you want QuickBooks to display (up to 20).

5. Click OK.

Alternately:
1. From the File menu, choose Close Company.
2. The No Company Open screen will appear.

3. Click Edit List to hide companies you no longer wish to see in this list or in the Open Previous
Company list.

4. Click a checkmark in the Hide column next to each company you no longer wish to appear in the

list.
5. Click OK.
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Get Started — Review Questions ARDE NT%

BUSINESS SERVICES

1. List the three main ways you enter data in QuickBooks.

2. List three ways to access features in QuickBooks.

3. What bookkeeping methods can you use to create reports in QuickBooks?

4. Which of the following would you not include in the Chart of Accounts?

a.

b.

C.

d.

Checking account
Vendor record
Depreciation expense

Accounts payable

5. Which of the following is an asset?

a. Accounts payable
b. Accounts receivable
c. Company delivery van
d. Bothaandb
e. Bothbandc
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6. Checking, savings and petty cash should be set up as which of the following account types in
QuickBooks?

a. Expense
b. Other current asset
c. Bank
d. Equity
7. Which of the following best describes a balance sheet?
a. A summary of a company’s finances over the past year
b. Afinancial snapshot of a company at a specific point in time
c. Asummary of a company’s revenue and expenses for a fiscal year

d. None of the above

Call or Email us for Correct Answers
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